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1 What is the Internet
1.1 The concept of Internet
At present, the term ‘Internet’ has become part of our everyday language. In fact, the
entire world understands its meaning in any sentence in which it is mentioned. But,
would we really know how to define what the Internet is?
The best known description is as a ‘network of networks’. But, this brings with it a
series of implications that need a wider definition and this is what we will now go on to
study in depth.
A network is a unit of computers connected to each other. This connection can be by
means of a cable, telephone line, or by sound waves in the case of a wireless
connection.
In the world there are millions of computer networks: public, private, national,
international, etc.
When we talk about the Internet we refer to a worldwide network, which encompasses
all those networks. This is possible thanks to communication through a common
language called TCP/IP.
The Internet, like all networks, is anarchic, and in theory, nobody looks after it. The
system’s maintenance is very simple: each organisation, business, etc. looks after the
running of their own network. If they do not do it and their network breaks down, it
simply is not included in the world network, and this was how the Internet was created
and has developed with the aim of continuing to function even if one of its parts
doesn’t.

1.1.1 Internet components
So that communication between computers of a network is successful, the presence of
a series of components is necessary. In the case of the Internet the elements present
are:
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Servers: high performance computers which offer services to its users.
Primary lines of communication between Internet nodes: they make up genuine
information highways. Together with the servers, they make up the backbone of the
Internet.
Clients: which are the computers with which the users connect to the Internet? These
clients can be inside or outside the network. When the client is outside, the secondary
lines of communication allow their connection with the Internet servers. This line is
usually a telephone line.
Specific programmes or software: are installed in each one of the nodes and makes it
possible for the network to work through a common language. This common language
is called TCP/IP.

1.1.2 TCP/IP
The TCP/IP is the base of the Internet, and it links computers that use different
operating systems, including PC, minicomputers and central computers on local area
networks (LAN) and wide area networks (WAN). TCP/IP was developed and
demonstrated for the first time in 1972 by the US Defence Department, running in
ARPANET, a wide area network of the Defence Department.

1.1.2.1 IP addresses
An IP address is a number which identifies in a logical and hierarchical way a device
interface (usually a computer) within a network that uses an IP protocol (Internet
Protocol). The said number should not be confused with the MAC address which is a
fixed hexadecimal number that is assigned to a card or network device by the
manufacturer, while the IP address can be changed.
It is usual that a user who connects from his home to the Internet uses an IP address.
This address can change on reconnecting; this way of assigning an IP address is
called a dynamic IP address (normally shortened to Dynamic IP).
Internet sites, which by rights, need to be permanently connected, generally have a
fixed IP address (the same reduction is applied by a fixed IP or a static IP), that means,
it doesn’t change over time. The mail servers, DNS, FTP public, and webpage servers
by necessity have to have a fixed or static IP address, so that in this way they can be
located on the network.
By means of the Internet, computers are connected together through their respective IP
addresses. However, human beings have to use other easier to remember and use
notations, such as domain names; the translation between one and the other is
resolved through Domain Name Servers DNS.

1.1.2.2 Domain
The way of understanding the domain notation will be to read the sub-domains from
right to left; this is, from the more general to the more private.
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In this way, if we saw “jd.misitioweb.es” we would understand that “es” indicates
the corresponding country as Spain; “misitioweb” represents a company or business,
and “jd” is the Server name of the company connected to the Internet.

1.1.2.3 DNS Service
In the same way as with machines, on the Internet, a unique name is given to each
connected user.
For example, “GonzaloM@jd.misitioweb.es” identifies the user as “GonzaloM” who
accesses the web thorough the server “jd” of the Spanish company “misitioweb”. In this
way, TCP/IP will be capable of distinguishing the users who connect to the Internet
through the same multi-user server.

1.1.3 What the Internet offers
The Internet, like any computer network, will simply offer us a support for information
and its exchange. However, servers connected to the web (and their owners) do offer
varied services to Internet users. We will now see some of the most common services:
One of the services that the Internet offers is that it allows files to be shared between
computers and thereby obtain programs and files of all types. This is called the FTP
service, based on the protocol of the same name, which consists of the communication
between client and server.
E-mail is, without doubt, one of the most useful services. With it, one can send text
messages to other people in a faster and more economical way than the traditional
postal service. This service has evolved to the point where we can send multiple
formats: multimedia files, text messages which are received in an acoustic format,
voice messages which are received as text and also mobile phone messages.
Another useful service is the news service or debate forums. This is a digital version
(on a world scale) of notice boards classified by topics. In these, users exchange
messages in a public way and can discuss every possible topic: hobbies, politics,
religion, sport, technology, etc.
Another interesting service is the traditional written exchanges or chats with other users
connected simultaneously to the web. However, traditional chats in written form are
being replaced by spoken ones. Just like telephone conversations, but at a much more
interesting price.
The World Wide Web or, simply Web, is without doubt the jewel of the Internet. This
service has been, more than any other, the one which has elevated the Web to the
technological and social position that it now occupies. At the beginning it was a
browsing system between documents based on hypertext. But nowadays, it has
changed into the basic service from which we access the rest of the utilities.
Electronic business, telework or virtual worlds are features which are quickly reaching
maturity thanks to the unconditional support of organisations and companies; and they
are revolutionising the way we do things at all levels.
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1.1.3.1 How to connect to the Internet
There is a structure of computers directly connected to the Internet through high speed
lines. This is called the backbone or vertebral column of the Internet. We have to bear
in mind that we will only have access to the Internet if our computer has this structure.
The connection to the web can be total, if our computer is physically in it; or partial, if
we access from outside. This last one is the most widespread between private users,
for which from now on we will refer to.
To connect partially to the Internet we will need a MODEM or router for our computer,
as the basic hardware necessary. Also we will need a communications line between
ourselves and an Internet server, which generally will be a phone or cable line; the
software, so that our computer is understood by the other computers on the Internet in
a way that you can access their services (employing TCP/IP); and finally a service
provider, generally a private company, which allows us to connect to one of its
computers situated within the Internet backbone.

1.1.3.2 The modem
A modem, acronym for Modulator-Demodulator, is a special piece of equipment which
allows us to connect our digital computer with the analogical telephone network in
order to transmit and receive information. Basically, it is a telephone for computers,
either internal or external, which offers the greatest possible communication speed.
Currently the most used are those which allow us to connect to high speed lines such
as DSL, CABLE, SATELITE, etc.
Basically all have the same function, which is none other than to connect us with our
service provider and to open the door for our PC to the network of networks.
Nowadays, the most used are those which incorporate a routing function, as in this way
a domestic network with various devices is configured in a simple and quick way to be
simultaneously connected to the Internet.
If our MODEM didn’t have a routing function, we would be limited, almost certainly to
the connection of one device at a time (desktop computer, laptop, PDA etc) to the
Internet.
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1.1.3.3 The communication line
The communication line is the element that allows the interconnection of two
computers, that is to say, the means of communication of our equipment with the
outside world.
If we have a modem/router, our communication line will be a telephone cable or fibre
optic. Not that this is the ideal means to connect to the Internet, but it is the most
economical because it makes the most of an existing network and reaches nearly all
homes.
If we are prepared to invest a little bit more, we could contract a satellite connection or
one through a cellular phone with which we could connect to a laptop from any place
with mobile coverage.

1.1.3.4 The communications software
The software that we need to connect to the Internet usually comes included in the
operating system of our computer. This software is responsible for controlling the
communication between the computer and the modem or that the network card is the
correct one. That is to say, it makes our computer be understood by other computers
on the Internet in order to exchange information and to correctly present the
information asked for. To put it another way, the communication software is really our
TCP/IP interpreter or translator.

1.1.3.5 The Internet Service Provider
Finally, if our computer is not physically in an Internet web, we will need someone’s
help to connect us to it. This is the figure of the Internet Service Provider. Basically, it is
a company that sells access to the web. The server which will unite us with the network
of networks belongs to this provider.
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One of its most important tasks will be to provide us with an IP address so that we are
not confused with other connected users and we can work with TCP/IP as valid Internet
clients.

2 What is the WWW?

The World Wide Web, the Web, or WWW, is a web navigation system which extracts
information elements called ‘documents’ or ‘web pages’. You can refer to ‘a web’ as a
page, site or group of sites that provide information, or to ‘the Web’ which is the
enormous and interconnected network available practically in all Internet sites.
The Web was born in 1989 from a CERN Project in which Tim Berners-Lee built the
prototype, which gave rise to what today is the World Wide Web. The original intention
was to make it easier to share investigation texts between scientists and to allow the
reader to revise the references of an article while reading it. A hypertext system would
link all the documents among themselves so that the reader could revise the
references from an article while reading it. The original name of the prototype was
‘Enquire Within Upon Everything’.
The basic operation of the Web is based on three standards: The Uniform Resource
Locator (URL), which specifies how each information page is associated to a unique
‘address’ where you will find it; the HyperText Transport Protocol (HTTP), which
specifies how the navigator and the server exchange information by way of requests
and answers, and finally the HyperText Markup Language (HTML), which is a method
to encode the information from documents and their links. Nowadays Berners-Lee runs
the World Wide Web Consortium, which develops and maintains these and other
standards that allow Web computers to store and communicate every type of
information.
The initial CERN program, ‘www’, only presented text, but subsequent web navigators,
such as Viola of Pei Wei (1992) added the capacity to also present graphics. Marc
Andreessen of NCSA presented a web navigator called "Mosaic for X" in 1993 which
skyrocketed the popularity of the Web among beginners. Andreesen founded Mosaic
Communications Corporation (nowadays Netscape Communications), adding
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additional characteristics such as dynamic content, music and animation which are
included in modern navigators. Often the capacity of navigators and server’s advances
are much faster than standard ones, which means that is usual that the newest
characteristics do not work on all the machines, impeding universal accessibility.
The unstoppable technical advance of the WWW today allows services in real time
such as web casts, radio web and webcams.
One of the new technologies in constant development throughout the WWW world is
Flash, a format registered by the company Macromedia which contributes a great
dynamism to the webs. The scripting language that they use, Actionscript, has great
potential that covers from the visual application up to the interactivity with the Server.
Action script, now in its 2.0 version, is making its way among the large web
programming languages.
Another important advance was the Java platform, from Sun Microsystems, which
allowed web pages to include small programs (called applets) that run on the client’s
machine and improve the presentation and the interactivity.
The web has grown cornering other forms of earlier communication, such as electronic
switchboards (BBS), news servers (News), the Gopher, the document searchers
(Archie) and it has maintained a certain coexistence with the files transfers protocol
(FTP) and the protocols of electronic mail: e-mail: SMTP, POP3 and IMAP, etc.
The W3C is the organisation which regulates web standards, necessary to ensure
universal access to the information. Even so, there are those who ignore these
standards, giving rise to web pages that can only be seen with one or a few specific
navigators.

2.1 How to navigate the World Wide Web
2.1.1 What is a navigator
A web navigator or browser is a software application that allows the user to recover
and visualize hypertext documents, commonly described as HTML, from web servers
all around the World through the Internet. This network of documents is called the
World Wide Web (WWW). The present navigators allow graphics, video sequences,
sound, animations, and various programs to be shown or run, as well as text and
hyperlinks or links.
The basic working of a web navigator is to allow the viewing of text documents,
possibly with inlaid multimedia resources. The documents can be located in the
computer where the user is, but they can also be in any other device which is
connected to the user’s computer, or through the Internet and which has the necessary
resources for the transmission of documents (web server software). These documents
are commonly known as web pages, which possess hyperlinks that link a portion of text
or image to another document, normally related to the text, or the image.
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The monitoring of links from one page to another, located in any computer connected
to the Internet, this is called navigation; which is the origin of the name navigator.
Another name is web explorer inspired by one of the most popular navigators Internet
Explorer.

2.1.2 How to access the information
To start to navigate, we need a starting point, for example, a web site. The web sites
are warehouses located in Internet servers where the documents published on the
World Wide Web are saved.
To access any of these sites, its home page is received, from which we can access
other pages in the network.
This first access is achieved by indicating to the navigator the name of the page that it
should show on screen. To do this, we use “http://” which is the WWW protocol. Now,
we indicate the name of the computer or the website with which we want to establish
contact. When a web site has organised its pages into directories, we will also have to
indicate in which directory the desired page is located. Finally, we will add the
document name or webpage to be viewed. This chain, which unequivocal distinguishes
one web document from another, is called the URL.
To access any of these sites, its home page is received from which we can access
other pages on the network.
To advance from one web document to another, we will use the links that the page
itself gives us, and that can be found mainly in text elements (normally underlined and
in a different colour) and in graphics.

2.1.3 Elements of a Web page
As we have just seen, a Web page can contain very diverse elements:
Texts: these make up the base of the information that the pages provide.
Graphics: a lot of them with movement to make the document more attractive.
Sound: a page can contain sound, although this type of element goes unnoticed if we
don’t have multimedia support in our computer.
Other elements: the text fields, the drop down selection lists, buttons etc. which are
usually part of the named formulas responsible for collecting information to send to a
server. Clear examples of these formulas are the search engines.
A usual technique in the construction of web pages is the creation of frames to show
more than one page at a time in the same navigator window. It’s most common use
consists of providing a selection menu and an information area which is refreshed each
time that one option of the said menu is selected.
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The inlaid active content programs are small applications which are run inside the
navigator and are destined to carry out very specific tasks, which are impossible to do
in any other way. These programs greatly enrich the pages, although it does make
them longer to load. Its main exponents are the Java and ActiveX applets.

3 Electronic Mail
3.1 Writing an e-mail message

Electronic mail or e-mail is a web service which allows users to send and receive
messages through electronic communication systems (normally on the Internet). All
this makes it very useful compared to ordinary mail, as it is cheaper and quicker. Along
with the messages, files as attachments can also be sent. An e-mail message, with the
same format as a letter, has a double structure. On the one hand, a body that contains
the message itself, that is to say, what it wants to communicate? On the other hand, as
if it were an envelope, a heading that will contain the name, and address of the
recipient, along with other data.
Normally, the e-mail client program will have editing tools that will facilitate the writing
of our letter, and will take responsibility for sending it.

3.1.1 Sending an e-mail message
3.1.1.1 Letter boxes
Just like traditional mail, in order to send and receive messages we
will have to have at our disposal a service that is responsible for
delivering the sent messages and a letterbox where received
messages are remitted.
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3.1.2 POP3 and SMTP
In computing Post Office Protocol is used (POP·3) in local mail clients to obtain the
electronic mail messages stored in the remote Server. The majority of subscribers to
Internet providers access their e-mails through POP3.
We will use a metaphor already known to explain the working of e-mail (Figure 1.14). A
postman of the SMTP mail service will collect the messages that we have sent and will
read the destination. With the help of other postmen from the same service, he will
transport it and will deliver it into the letter box of the address indicated. If this letterbox
did not exist, then he would also be responsible for returning it to us.
To read a message which we have received, we only have to take it out of the
letter box by using our e-mail client program, which uses the protocol to bring
messages from the ISP Server to our computer and then show them to us.
There are other protocols, such as IMAP24 (Internet Mail Access Protocol version 4)
although the POP3 is the most extensive.

3.1.3 Receiving an e-mail
To be able to receive your electronic mail we will use a letter box, a different one to the
one used to send our messages. The SMTP postman himself will be in charge of
depositing all the messages coming in, those that are sent to us as well as those that
are sent back to us because of a mistake in the sender’s address.
If what we want is to read the e-mail messages received, we only have to connect to
our usual electronic mail program as this will be in charge of storing and classifying by
means of different criteria depending on the information that we receive by way of
email.

3.1.4 Advantages of e-mail
Although Internet mail works as a normal mail service, it has a number of advantages
over this.
Nowadays we can include nearly any type of file and therefore it can be used as a
quick and efficient way to send information to friends, clients, family, etc.
Videos, photos, etc. are some of the examples of material that we can attach to a
message.
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4 Search engines on the web

4.1 Vivisimo: www.vivisimo.com
Vivismo is an innovative search engine that aspires to find an opening in a sector in
which Google’s dominance does not leave many surprises.
Its radical originality is that it is a search engine that organises the results of its
searches in clusters (groups) of associated environments, which allows us to save time
and have a rapid vision of the global results, although it deals with thousands of them.

4.2 Yahoo!: www.yahoo.es
It is one of the most extensive thematic indexes - and most used - on the Web. Its use
is very simple, as the web pages present complete menus organised into categories
that allow us to get closer in a gradual way to the pages that most probably contain the
information we are looking for. In each stage of the search, it is possible to enter one or
various key words in order to locate the links that contain them, either in Yahoo’s entire
index or just in what appears on screen.

4.3 MetaCrawler: www.metacrawler.com
This is another of the key search engines that we can find on the Internet, one of the
first and most thorough on the web. It offers a large quantity of options to configure the
search, with you being able to choose what results are given related to images, music,
programs, videos etc.
The portals are the present of the Internet, they are enormous Web sites in which you
can find a large quantity of Web pages organised according to the categories with
which they are related, along with a multitude of services: shopping, news, e-mail,

Page 15 of 48

Module 1

ITC - Internet

messages to mobiles, street maps and even chat and translation services.
Increasingly, the pages tend to join forces with these portals, in a way that their
presence on the Web is greater and the result is that it is much easier to locate content.
Let us look at some of the main portals.

4.4 Google: www.google.com
Google Inc, the company of the trade mark Google, is a company whose main product
is its search engine, which has the same name. It was founded on 27 September 1998
by two computer doctorate students, at the engineering school of the University of
Stanford, Larry Page and Sergey Brin. Although its main product is the search engine,
the company also offers other services, a price comparison site called Froogle, a
search engine for material stored on local discs called Google Desktop Search, and a
service which has revolutionised the world of free electronic mail, called Gmail, whose
users have at their disposal more than 2,7 GB of space and is constantly increasing by
around 4 bytes a second. Recently it launched its beta version of instant messaging
Google Talk.
At present Google is working on various projects to increase its number of Internet
users and facilitate resources so that these users can access the web. Among these
projects, the following stand out, PC for 100 dollars, GNU applications, Google Docs
and Spreadsheets, collaboration and promotion of free software applications such as
Firefox, installation of various free wireless networks, development of a protocol system
open to voice communication, as well as others. In addition to this it is speculated that
Google will be working on the development of an operating system, a Google Office
and a global fibre optic network.
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5 Enjoyment on the web
The Internet has become one of the main sources of leisure time activities. Its content
diversity, which adapts to all members of the public, means that children as well as
adults, both men and women, have a place on the web.
At present the services dedicated to leisure time are constantly increasing and the
proposals for leisure and free time are so high that it makes it difficult to keep up to
date with all the new developments.
Services such as video clubs, supermarkets, radios, televisions, restaurants,
museums, etc. are on the web, in a quick and accessible way. We will now go through
these resources in a more detailed way.

5.1 Online Radio
The classic radio has found on the Internet a way to spread its contents, as much for
the programmes of normal radio stations as for those who purely broadcast their
contents on the Internet.
www.radiointernet.fm
This virtual radio station, that only offers its contents on the Internet, and not over the
classic radio waves, offers thematic contents centred on the world of the Internet. It
also offers the possibility that, in the event of missing a programme, we can listen to it
by accessing an audio file on the same page.
Unlike the previous one, in this case, it deals with a worldwide radio station, it
broadcasts in Spain, Catalunia, America, and even Rumania and it gives access to
various radio stations in these countries, although some of these are in English. As well
as these radio stations, the majority of national and foreign radio stations have
webpage’s in which it is possible to consult their programmes, and even be able to
follow their broadcasts on the Internet, such as for example www.emisiondigital.com,
www.ondacero.es, www.europafm.com and many others that you will be able to find
easily with a search engine.
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5.2 Games
The Internet has supplied a new scene for the typical computer games, allowing the
creation of new games that develop by means of collaboration between users who find
themselves in different places, even in different countries, all connected together
thanks to the possibilities offered by the Internet.
On-line games (or Internet games) are those videogames played over the Internet. The
main difference with other console or computer videogames is that these are normally
independent of a platform, based exclusively on technology from the players (normally
called plug-ins or players). Normally, all that is needed to play the game on line is a
web navigator and the appropriate plug-in.

5.3 Sport on the web
Sport also has its place on the web, and a very big one for sure. There are many Web
pages that we can find on the web, full of sport contents, whatever the sport we are
looking for. Web sites, nearly portals, such as www.spor-tec.com offer on its pages
multiple information about many sports, whether it be basketball, motor sports, tennis,
cycling or of course football (which by the way, occupies the majority of the sport pages
in Spanish). In the same way there are other portals, such as for example
www.deporWeb.com that offers information on four or five major sports in Spain
(football, basketball, cycling, motor sports and tennis).

5.4 Cinema on the Web
The information about the cinema on the Internet is nearly unlimited. To the brand new
formula for buying your tickets on the web, choosing the cinema, day and seat, there
are other numerous services which have since been added.
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The Portals dedicated to film lovers have forums with thematic reviews that help us to
know which films to choose when visiting our local cinemas.
Just like this the most famous cinema festivals have their own web pages in which to
spread their main activities.
In this way, the Internet has opened a window to novel producers or writers of short
films who now have a place where they can get their work known.

5.5 Humour on the web
The Internet is one of the best places to enjoy humour. You don’t have to do anything
more than make a small search and you will find hundreds or thousands of pages
related in some way to humour: jokes, comics, video comics etc. To find all types of
files that will ensure you have a good time, navigate the web:
We can highlight some examples:
www.youtube.com: The major video online warehouse which makes the most of
numerous television programmes when filling its contents. It has a very powerful
search engine that allows us to find in a very efficient way the video we are looking for.
Recently youtube.com has been bought by Google.
http://www.ahajokes.com: A portal in English in which we find jokes and videos
classified into types: fun videos, fun photos, funny jokes, are only some examples of
the categories that we can find on this complete web page.

5.6 Free Applications
Freeware is computer software that is distributed free of charge. Sometimes the source
code is included, but this is not usual.
The freeware usually includes a user license, which allows its redistribution but with
some restrictions, such as not modifying the application, nor selling it and
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acknowledging the author. Forbidding is its use, in a company with commercial aims or
a governmental body.
The term was created in 1982 by Andrew Fluegelman, who wanted to distribute a
program that he had written called PC-Talk, but he did not want to use traditional
software distribution methods. Fluegelman registered the term freeware, but these
author rights have now been abandoned. In fact, the method that he used to distribute
PC-Talk today is now called shareware.
Some developers release freeware versions of their products to obtain a number of
followers that will be prepared to pay for a more complete version, or because it is an
obsolete edition of a program.
Others do it because they do not consider that their program can generate any
economic gains, or because they believe in the value of offering something for free.
Contrary to what is believed, the free software programs are not necessarily freeware.
This usually comes from confusion over the meaning of the word free, which can be
free as in no need to pay or free, as in a type of software whose license authorizes its
use, change and redistribution with or without changes.
Other types of distribution licensing of software are shareware, postcard ware, donation
ware, or abandon ware.

5.7 Press
The web can be a great means of information for all those people that at a certain
moment of time do not have another means nearer or it can even be for comparing the
news in various means of communication.
Nearly all national newspapers have electronic versions that can be accessed from
your computer, which allows you to stay completely up to date with the latest news
generated in Spain and abroad. However, there are also some newspapers published
solely for the Web, whose only presence is (at least for the moment) through this
medium. For example, we can find Estrella Digital, one such newspaper which is found
on the Internet and appears to be like a normal newspaper, presenting a front page
with main stories that access the other pages which contain the news developments.
You can find this at www.estrelladigital.es.
Probably one of the tasks that has most evolved in the last few years thanks to the
development of the Internet is job searching.
A few years ago there were only a few national agencies in each country and some
private job searching companies worldwide, but in the last few years a multitude of
agencies on the Internet have appeared which offer mediation services in the search
for work to all its users. Here are some of the possibilities that are available to find work
through the Web: www.monster.es, www.infojobs.net and even www.freelance.com
(this is specialised in looking for work for self-employed people), these are some of the
most well-known sites, with the most movement in the search for work.
If with the above agencies you don’t find what you are looking for, don’t give up,
as there are dozens of Websites specialised in this area. If you want to find more sites,
you can go to any of the search engines we mentioned at the beginning of this topic
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and search using key words such as work, job or job offers. With some patience you
will hopefully get the results that you want, but just in case, you might be interested in
visiting http://es.dir.yahoo.com/Zonas_geograficas /, in which you will find a directory of
companies for different countries that Yahoo has compiled.

5.8 Shopping on the Web
Until a few years ago it was absolutely necessary to leave the house to buy something.
Then, home sales appeared which, although at times it was comfortable, it didn’t make
up for the fact that hundreds of door to door salesmen called at your house, trying to
sell you anything from encyclopaedias, hoovers, blenders, to the latest language
course. However, nowadays, all these drawbacks have disappeared. The Internet
gives us a tool with which we can buy nearly anything in the market without having to
leave the house. From a record to a pair of trousers, even a car, everything can be
bought on the Internet. Let us have a look at some examples.

5.8.1 Shops and virtual supermarkets
Online shopping in shops and supermarkets has made life much easier for the
consumer. Nowadays we can connect on-line to our local shopping centre and look at
the catalogue, add items to our shopping trolley and finally confirm the order. If we are
not happy about making a payment online with our credit card, we can always pay on
receipt of the goods.
The virtual visits to the supermarket are increasingly more accepted and numerous
companies are adding this method of buying, thereby offering an added value to their
customers.
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5.9 Official organisations
One of the tasks which all of us waste the most time on is paperwork that we have to
do with different state bureaucracy. The Internet has not yet developed the way to do
all of these from home (although it tries) but it does provide us with various tools, which
even if they do not solve our movements completely, at least offer us a large quantity of
information necessary to do these processes later.
The clearest example is online banking. Nearly all of the banks have online systems
which allow the user to connect from home, check their accounts, pay fines, make
transfers, payments etc.

5.10 Children
So that children do not think that everything on the Internet is information and boring,
there are a multitude of sites dedicated especially to them, offering them all types of
contents to have a good time and discover a new world of fun and entertainment.
Some of the most famous pages are listed in the following section:
http://www.webfoundations.com/JustForKids/: a classified directory with many pages
appropriate for children, with content from a recreational aspect to the more
educational.
http://disney.go.com/home/today/index.html : an interesting web page for the youngest
children. A multitude of games, activities, competitions, quizzes, prizes, etc.
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6 Lists and news
E-mail is very useful, as it allows us to send messages very easily to any Internet user
but only if you specify their e-mail address. You will only be able to send electronic
messages to the people whose addresses you know beforehand. For this reason, you
won’t be able to send messages to people you do not know. But, why would you be
interested in sending messages to strangers? Maybe because you might have
information which might interest them or you may want to ask them something. The
Newsgroups are the electronic equivalent to a notice board. Once more, as occurs in
all electronic equivalents to the physical world, the newsgroups are more versatile,
quicker, and cheaper than classic notice boards.

6.1 What is a mail list
Mail lists are a special use of e-mail which allows the massive distribution of
information between multiple users of the Internet at the same time.
In a mail list you write an e-mail to the address on the list (for example:
lista@address.org) and it reaches all the people on the list, and depending on how the
mail list is configured, the user will be able to have the possibility of sending mail.
Sometimes lists with thousands or even millions of electronic addresses are used for
the sending of junk mail or spam.
A lot of organizations are increasingly using this tool to keep people informed,
principally with news, publicity or any information of interest. In order not to fall into
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spam practices, the mails are sent following registration by the recipient, giving them
the opportunity to cancel it when they wish.
The electronic mail lists usually work in an automatic way, through the use of a mail list
manager and an e-mail address capable of receiving e-mail messages (the mail list
address).
The messages sent to the said address are resent to the e-mail addresses of the
subscribers on the list. Depending on the server’s software, there can be various mail
addresses to receive commands.
Many electronic mail list servers offer a mail address so that the subscribers can send
commands, such as signing up, cancelling, or changing their subscription preferences.
Some electronic mail lists servers allow as well various ways of subscription (individual,
digest etc.)
Another type of e-mail list is known as an electronic bulletin, which is used mainly in a
uni-directional way of information and in which only certain people in charge of this
bulletin can write.
Another type is the debate list, in which any subscriber can write. In a debate list, a
subscriber uses the mail list to send a message to the rest of subscribers, who can
respond in the same manner. Like this, debates and exchanges of information can be
generated. The lists of this type are usually related to a particular topic (for example
politics, jokes, pets), and the themes can be from the most specific (for example people
suffering from diabetes) to the more extensive, such as “anything that interests you”. In
this way it is similar to the Usenet groups.
In some debate lists, the sent messages should be first grouped by a moderator before
being sent to the subscribers. The use of moderators is usually used to maintain a high
level of quality and avoid the sending of mail messages as junk e-mail or spam. Some
of these lists are open to whoever wants to subscribe, while others need the approval
of the list owner or a moderator.
Netiquette rules
Many groups or mail lists have their own regulations or netiquette rules, which help the
coexistence and harmony of the participants on the list. Some netiquettes can be, for
example: treat each other with respect, avoid using certain words or terms, be brief, do
not send attached files that are over a certain ‘weight’ as not all may have the same
rate of connection, always send messages relative to the subject on the list or if not
label them as ‘off topic’ in the Subject field, avoid sending chain mails, etc.
E-mail list services
The Internet services which allow the creation of electronic mail lists in a simple way
were very popular at the end of the nineties, but after the bursting of the .com Bubble,
many of the said services disappeared, leaving mainly the most popular ones such as
Yahoo! Groups or eLists. In 2004 Google also launched a basic mail list service,
integrated with the Usenet groups.
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6.2 Starting the application
As always happens with the client programs of any type of service, before being able to
enjoy it it is necessary to configure it. In the next part, you will see the way to set up
Microsoft Outlook Express.
Before going into details on each program, you should know the address of the news
server to which you can connect. There are hundreds of servers on the Internet, but
some will only allow you to connect to them if you belong to their network or if you pay
a small charge. In the end, not everything is free on the Internet.

6.3 Configuring Outlook Express
Outlook Express is a mail client which comes as a default application in all the present
editions of Windows, which means that at first we do not have to worry about its
installation. Outlook is not just a mail client; it is also a useful client of newsgroups,
which is completely free. We will now give you the necessary steps to access “the
news”:

6.4 Newsgroups and Distribution Lists
Connect to the Internet and open Microsoft Outlook Express. When you have loaded it,
select the Tools > Accounts menu
Outlook will show you the Internet Accounts configuration window. Select the News
tab.
Click on Add > News. An Assistant will ask you for the necessary data to configure a
news account in a server. Write the name you want the rest of the users to see and
click on Next.
Write the e-mail address which you will make public. In this way other users will be able
to locate you in a private way. This resource is very interesting, as it allows the use of
the public aspect of the group to find a person to then talk in private. Bear in mind that,
being available in a newsgroup will undoubtedly lead to some address search engine
noting this and later flooding you with junk mail. For this reason, it is better to use a
mail address that isn’t your main one or give a false address such as
someone@microsoft.com, as Outlook itself suggests and click on Next.
Then, Outlook will ask you for the news server address which it located before. Write
this in the box and click on Next and Finish.
Click on Close to leave the Internet Accounts configuration window. Outlook will ask
you if you want to download the list of newsgroups from the recently added server.
Answer with a click on the OK button. This step is vital.
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For some time, Outlook will download the newsgroups list. Be patient. This process is
slow even with a fast connection, but you will only have to do this the first time, and
every now and then, to be up to date.
When downloading has finished, you will be able to choose the groups to which you
wish to subscribe.
Select those which you think are the most interesting and click on the Subscribe button.
When you have finished, click on OK. You can write part of the name in the Show the
newsgroups box so that Outlook filters them and only shows you those that contain that
text chain.
Knowing that some groups are more interesting is not something immediate. It will help
you to understand the system used to give them names. The names of the groups are
made up of different terms, which range from the more generic to the more specific.
This is the meaning of some of the terms used in the names of the groups:
rec: The messages sent to these groups are previously read by the moderator, who
then accepts them or not. They do not usually contain messages inappropriate to the
theme.
alt: From Alternative. Groups without a moderator. Here you can expect to find all type
of messages in these groups.
comp: Thematic groups related with computers (COMPuters).
soc: SOCial thematic groups.
sci: Groups with contents related to sciences (SCIence).
2600. Groups related with the world of computer pirates or hackers (2600 is practically
synonymous with computer piracy, for historical reasons).
bbs: Groups of messages related to the BBs systems, some amateur electronic
conference systems that many consider the predecessor of the Internet.
Culture: Messages are related to culture in its widest sense.
fan: These groups are dedicated to the fans of any famous person or phenomenon.
There are some that are truly incredible. If you have time, have a look at the group list
alt.fan…
flame: A flame is a content message, which, let us say, is controversial. The flamewars are the wars of exchanging messages on the most explosive themes. These
groups are dedicated to constant controversies. Visit them if you like arguing.
folklore: Groups whose messages deal with aspects related to folklore and customs of
any social group in any part of the world.
games: Groups which theme is based on games, generally on video games.
The most common process consists of subscribing to many potentially interesting
groups, navigating around their contents and then eliminating the ones that you are not
interested in. After a short period of time you will be left with the groups that only
contain useful information.

6.4.1 Receiving and reading
Next we are going to explain how to use the Outlook program which we have already
configured to receive and read messages. You will discover how to read messages in
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the newsgroups, how to recover files which can be attached to messages or the way in
which the chain messages are organised.

6.4.2 Accessing news with Outlook
Connect to the Internet and start Outlook Express. The management of messages is
very similar to those carried out with e-mail messages. The only difference stems from
that here, when double clicking on the name of a mail server, a list of subscribed
groups and their contents will drop down and be shown in the other windows.
The top left part of the panel contains the folders in which you organise the messages.
Scroll towards its bottom part until you get to the name of the news server which you
have configured in the previous sections.
Subscribe to newsgroups which distribute files such as the one used in this example,
esp.binarios.Images. Locate the group of messages that contain the file that you want
and select all. The best way of doing it is to click first on the Subject heading of
Outlook, so that the program orders the lists of messages by their subjects. In this way
all the messages with similar titles will appear one after the other. Take notice, that
generally all of them will have the same title, except for a small numeric field that
indicates the quantity of messages and the order of each one inside the unit. For
example, if a file has 13 messages, these will go from file (01/03) until file number
(13/13).
Select the first of them, go to the last and keeping the Caps Lock key Caps pressed
down, click on them. With the entire message list selected, right-click on it and select,
in the contextual menu that appears the option combine and decode… A window will
appear on screen indicating the progress of the operation. When it finishes, Outlook will
show the result of this combination. The most common case is in the downloading of
an image/picture. When you have it on screen, right click on it and select, in the menu
which appears, Save image as…Select the folder on your disc that you want to use
and click on the Save button.

6.5 Discussions
In the newsgroups, the messages are usually in sequence. When a newsgroups user
sends a message, on a lot of occasions they usually have an answer. Given that all the
answers usually have the same Subject: from the original message but preceeded by
Re: it is easy to see which messages are related. The mail client uses this information
to join all the related messages. Whenever you see the + sign on the left of the subject
of a message, remember that this line contains the original message and various
messages more in response. Click on the + sign so that Outlook shows the complete
list of messages from the chain. Double click on the first of these to view it in a
separate window. When this opens, use the before and Next buttons to scroll through
the message chain and read all those that interest you.
Subscribe to newsgroups which distribute files such as the one used in this example,
esp.binarios . Images. Locate the group of messages that contain the file that you want
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and select all. The best way of doing it is to click first on the Subject heading of
Outlook, so that the program orders the lists of messages by their subjects. In this way
all the messages with similar titles will appear one after the other. Take notice, that
generally all of them will have the same title, except for a small numeric field that
indicates the quantity of messages and the order of each one inside the unit. For
example, if a file has 13 messages, these will go from file (01/03) until file number
(13/13).
Select the first of them, go to the last and keeping the Caps Lock key Caps pressed
down, click on them. With the entire message list selected, right-click on it and select,
in the contextual menu that appears the option combine and decode… A window will
appear on screen indicating the progress of the operation. When it finishes, Outlook will
show the result of this combination. The most common case is in the downloading of
an image/picture. When you have it on screen, right click on it and select, in the menu
which appears, Save image as…Select the folder on your disc that you want to use
and click on the Save button.

6.6 In search of news
As you will have now seen, the message list of a group can be enormous. When you
want to locate a message there is no need to look for it one by one. Outlook has a
search command with which you can define what criteria to use to locate the messages
that you want to read. Click on the Search button in the upper part to access the search
window. In it you can specify the content that one or more fields in the message should
have: From, To, Subject, Message, Received before the, Received after the, the
message has data attached, and if the message is marked. If you want to look for a
message whose title contains, for example, the text ‘bridge-hall’, writes it in the Subject
field and presses the Search button now. Outlook will show you in the bottom part of
the search Window the matches it has found. Double click on any of them to access its
contents. Remember that this search is only carried out on the contents that you have
already downloaded (message list and the downloaded messages), not all the
messages in the group.

6.6.1 Participating in groups
Up to now, you have seen how to access the contents of the newsgroups. Wouldn’t
you like to know how to contribute to these? In the following sections you will see how
to create your own messages, either with a new theme or as an answer to existing
messages.

6.6.2 In Outlook
Select the group to which you wish to send a message and click on File > New > News
message. This will make Outlook show you the window called New Message, which
contains various fields. The first, News Server, is a drop down menu, in which you can
select the newsgroups’ server to which you want to send the message (only if you have
more than one configured). The second field, Newsgroups, shows the name of the
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group that you have selected at the beginning and to which the message is going to.
The CC field will allow you to write one or several mail address to which a copy of the
message will be sent. The last field, Subject: contains the title of the message. Try and
be as descriptive and concise as possible so that the rest of the users in the group
know what they are going to find in the main body of the message, just from reading
the title. Just below this last field is the editing area, in which you should write the
content of the message. Including a file with your message is very easy, you only have
to click on Insert > File and, in the window that appears, select the files you want and
click on the Insert button. When you have finished, click on the Send button to send the
message to the group.

6.6.3 The answer
Answering a group message is very similar to creating one. In the first place, select the
message to which you wish to answer. Then, press the Answer the group button. The
fields should contain the same data to create the message. The difference is in the
Subject field: you will have the title of the original message preceeded by Re: to
indicate that it is an answer and the body of the message will contain the text of the
original message. In this way you will be able to arrange the original paragraphs.

7 Communicating on the web
The Internet is a tool whose main purpose is to facilitate communication. As we have
seen up to now, there are many communication services, such as Web pages with all
types of contents or electronic mail. The publication of Web pages is the electronic
equivalent of paper publication. The electronic mail, even more so, is the electronic
equivalent of the traditional postal service. So, is there an Internet equivalent for phone
calls? And of course, the answer is yes. Over the course of this chapter the most
popular and useful in real time connection systems such as IRC or instant messaging
services of Ya.com and MSN Messenger will be looked at. In fact, you can really talk
about ‘telephone through the Internet’, although the various systems are so little
widespread that it is not really a useful service.

7.1 mlRC
mIRC is the most extensive IRC client for Microsoft Windows platforms.
Its author is Khaled Mardam-Bey, and its download is available from the official mIRC
webpage.
mIRC is software with a shareware license and its evaluation period is 30 days. After
this evaluation period to be able to keep on using the program, you have to pay a
license fee of $20 (US dollars) which is valid for any new version of mIRC. In reality if
the license fee is not paid the program is not blocked, you simply have to wait a short
time for the program to run in order to be able to use it.
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It uses its own scripting language for the programming of plug-ins. In the jargon of
mIRC it is called script to that group of scripts programmed to work in conjunction and
that influence the client in all aspects (from the condition and configuration of menus,
appearance, events, new configuration panels and other tools). A script programmed to
deal with a specific task is known as an add-on (normally known as plug-in).

Installation
Now we will show you the steps needed to download the mIRC program and to install it
on your computer.
Connect to the Internet and Start your preferred Web page explorer, such as Internet
Explorer.
Write www.mirc.com in the navigator address field and press the key Enter. The mIRC
web page will open.
Click on the link Download mIRC from the column on the left hand part of the screen.
Scroll towards the bottom part of the page until you locate the link called mIRC xxx in
France and click on it. It will more than likely be the fastest of all those indicated.
Your navigator will probably alert you to the dangers that can occur when downloading
a file if you are not sure of its origin. As you are accessing the file from the official Web
program, there aren’t any problems. Click on the Save button and select the folder on
the disc in which you want to store it. Finally, click again on the Save button to begin
the download.
When you finish downloading the file, locate it on your disc and double click on it. The
name of the version used in our case is mirc603.exe.
Click on the Next button and then Yes.
Select the folder in which the program will be installed in the Destination folder box and
click on the Install button.
The installation program will copy the necessary files onto your disk and will create a
shortcut to them in the Start menu. Click on the Finish button.

7.1.1 Connecting
Now we will show you the necessary steps to start the IRC client and connect with a
server to talk to other users.
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Go to the Start>Programs>mIRC>mIRC menu. Close the information window that
appears.
The mIRC Options window will appear from which you will be able to select the
connection options for this IRC session. Select the IRC-Hispano value box in the
IRCNetwork drop-down list. IRCNetwork.
Fill in the Full Name field with your name. Write your e-mail address in the Email
address field and lastly, write the nickname that you would like to use in the Nickname
field. When you have finished, press the OK button.
To connect to the selected server, click on the Connect button. After a few seconds,
the program will notify you as to whether you have been able to connect or if there is
any problem. It will also probably show you a list of predefined channels.

7.1.2 Main Screen
Now you can start to chat. Although beforehand you should know something about the
different program elements. The top part of the window has the menu programs, from
which you can access all the options and with which you can run the most common
IRC commands without having to write them. Just below the menu bar you will find the
button bar, which has the buttons for you to be able to disconnect (Disconnect),
configure the program (Options), see the list of channels available (Channels List) or
transfer files to other users (DCC), among many others.

Under the button bar an icon will be shown for each chat window that is open. You only
have to click on the icon to hide it or show its corresponding window. The windows of
the central zone show the period of time of the IRC session.
Just below the central windows there is a field with a flashing cursor, this is the
entrance field. From here you can write the sentences that you want to send to the chat
or the IRC commands, if you prefer to do it this way. In general, it will be better for you
to start by using the menu commands. When you understand how everything works,
then it may be the moment to learn the text commands and so go faster, but not before.

7.1.3 Channels
As we have seen before, in each IRC Server various conversations take place on
various channels at the same time. Each one has a name and a list of occupants at
each moment, who have a window open in their IRC client, to read what the others
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write and to write themselves. To see the list of server channels, write /LIST in the
entrance field. A window will open with a list of channels. On the right of the name of
each one, a number will appear that indicates the number of users that are present at
that moment.
Select one of these and double click on it. You can also right-click on it and in the
contextual menu that appears, select Join Channel. Another way is to write the
command /JOIN # channel in the entrance field and press Enter. The three ways are in
fact the same. When you select the option Join Channels in the channel window or
double click, mIRC sends the /JOIN #channel in the same way that if you had written it.
As you will see nearly all the mIRC buttons and menus are used to hide the complexity
of the IRC system of commands. On a lot of occasions, mIRC ‘sees’ a written order in a
graphic way.

7.1.4 To Chat
Once inside the channel, you will see a window divided into three parts. The left hand
side, that occupies the biggest part of the window, serves to show the status messages
and what the users write. Each time that someone writes a sentence and presses the
Enter button, this will appear in the central window preceeded by its nickname, to see
who is talking. The right hand part shows the list of connected users to this channel.
This list is updated constantly. Lastly, the entrance field in the bottom part is for you to
write what you want to communicate to the rest of the users of the channel, as well as
to write commands, if you think it is necessary. Some channels have many users. If the
lines appear so fast that you don’t have time to read them, use the scroll bar in the
principal window to go to the contents that interest you.
You will more than likely feel very lost at the beginning. Everybody seems to know how
IRC works. They enter and leave the channels at great speed and write very quickly.
Don’t worry; with time you will see that it isn’t so quick. This impression will change as
you get used to using the mIRC program. Also, take into account that mIRC has
command sequence functions; this is, so that a simple action by you can be
programmed, so that pressing a button can activate an extensive series of commands.
Also, timers can be activated so that the program carries out actions automatically,
without any intervention by you. A lot of the things that you see are not typed by one
person at that speed, but are automatic commands.
This allows, for example, for a single person to be connected to many channels and
that the program advises you when you know someone, with a specific nickname,
connects to one of them. Think of these people as a type of high-speed user. Although
they coincide in the same channel with you, they don’t go at the same speed. Each one
will be dedicated to elegantly ignore the other and concentrate on them, which in their
case is to start off conversations with other users. If you want to start up a private
conversation with any user, you only have to double click on their name so that a new
window opens in which you can chat alone.
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7.2 Other options
You can also connect to various channels at the same time. To do this go to the
window containing the list of channels and double click on another channel. A new
window will open with the activity of that new channel. At any time you can go from one
window to another with the buttons in the top part. Remember that a button will appear
for each window that is open. If you prefer you can select Window>Cascade to show all
the Windows cascading. This will make it easier to choose the one that you want at any
moment, although you will loose part of the screen space.

7.2.1 Chat services.
As well as the chats by IRC, there are many other systems to chat. At the start of the
Internet boom, nearly all the services were used equally. Although, shortly after Web
navigators became popular, the content in HTML eclipsed all the others. At that
moment there were many people who were dedicated to adapting existing services to
the new format. Given that on the Internet everyone had a navigator and knew how to
use it, why force them to download and learn a new program? This simple idea gave
expression to a number of chat services which you can access through a Web
navigator. Obviously they have their limitations and the more advanced users will miss
many characteristics, but for the majority of people they are more than enough.
The majority of the big portals have their own chat systems. Curiously, in the chats
through the Web you do tend to talk about rooms in place of channels as in IRC. Many
of the chats on the web need Java to be installed on your computer. If this is the case,
follow the instructions in the next section to be able to update your navigator and to be
able to access their chat.
The chats on the Web are very similar to the mIRC program, but you should take into
account that they don’t follow a standard as they do in the IRC chats program. Each
chat system on the Web is owned by that Web, and although they all seem to be the
same, with time you will discover that there are small differences. It is very possible
that one has the characteristics that another may lack. Fortunately, they are usually
very simple to use, making their use for first time users easier. Everything that may
seem intimidating in IRC is the total opposite here. Maybe that is why the more
advanced users tend to use IRC chats, while the Web chats are for users that are less
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worried about managing the program one hundred percent, but are in fact more
interested in the direct communication between users.

7.2.2 Installing Java on the navigator

The Java Virtual Machine (JVM) is a native program, that is, run able in a specific
platform, capable of interpreting and running instructions expressed in a special binary
code (Java bytecode), which is generated by the Java language compiler.
The Java binary code is not a high level language, but a true low level machine code,
viable as an entry language for a physical microprocessor.
The great advantage of the Java virtual machine is to contribute mobility to the
language. SUN has created different Java virtual machines for different architectures
and also a class program written in Windows which can be interpreted in a Linux
environment. It is only necessary to have the said virtual machine for the said
environments.
However, the attempts by the owner company of Java and derived products, which is
Sun Microsystems, to construct microprocessors which will accept the Java bytecode
as its machine language were unsuccessful.
The virtual Java machine can be implemented into software, hardware, a developing
tool, or a Web browser; it reads and runs precompiled bytecode which is independent
of the multiplatform platform. The JVM provides definitions for a group of instructions, a
group of registers, a format for classes of types, the battery, a heap to collect rubbish
and a memory area. Any implementation of JVM which is approved by SUN should be
capable of running any class which meets with the specification.
There are various versions, in chronological order, in the Java virtual machine. In
general the definition of Java bytecode doesn’t change significantly between versions,
and if it does, the developers of the language make sure that it is compatible with
previous products.

7.2.3 Home page of Inforchat
As is becoming usual in the home pages of all services on the Web, each zone is
dedicated to a function. In the top part of Inforchat’s home page there is a series of
links to other pages of the Ya.com group. Just below these you will find various buttons

Page 34 of 48

Module 1

ITC - Internet

with different functions. You will be able to start up a chat SMS, include for free the
Inforchat in your Web (Free), reserve the nickname (Register your Nickname) or get
help (Chat Help). A nickname is the name you will use in the Chat session. On
registering it, nobody else will be able to use it. This is an interesting option if you are
thinking of frequently accessing this Chat, as your nickname is the only thing to identify
you to the others. If you choose not to register it, you may find somebody else using it
one day and you will have to use another for that session.
Reserving a nickname is very easy, but you have to pay. This is a small amount
(between 0,9 and 3,5 euros depending on the duration). The process is simple, you will
only have to write the alias you want, and if it is available, fill in a simple questionnaire.
At the end of the process the system will ask you to select the length of time that you
want to reserve it for (3 months or 1 year).
It is recommended that you try a chat, and if you see that you like it, decide if you want
to maintain a lasting ‘electronic identity’.
The panel on the left hand side shows some general information on Inforchat. The
number of users connected (Users online), the quantity of operating channels (Active
channels) or the top 10 most successful ones (Top 10). Another interesting link is the
basic dictionary, which will show you some of the more commonly used terms in chats.
As well as the previously mentioned nickname, it is important to know these two: Ban
and Private. To ban a user is to prohibit them access to a channel. To go to private is
to open a private communication channel with another user, that is, a chat just for two.
With this minimum introduction, you are now ready to plunge into your first chat
session.
Starting a session
Click on the Inforchat Zone link in the central part of the screen, in order to move on to
select a channel in which to converse. The system will ask you to select a thematic
area (entertainment, hobbies and sport, etc.). Then it will show you the channels
included within that thematic area. You can select whichever one you like the best, or if
you want to make sure the channel is active, choose one of the channels mentioned in
the Top 10 section on the home page.
When you choose a channel, Inforchat will ask you to specify a nickname and a
password to identify yourself. Then the screen will change its appearance and show
you various panels. The main one is in the centre of the window and will show you
what all the users are writing. In the top part you will see information relative to the
nickname used and to the channel in which we are in under the central panel you will
find a Chat field, where you should write the texts that you want to share with the other
chat users. In the top part and in the right part you will see many links which we have
already mentioned (Chat areas, Channels, Registering a nickname, chatting by SMS,
various services of Ya.com etc.) The Users box shows a list of all the users active at
that particular moment in the channel. If you double click on one of them, you will be
able to establish a private conversation with that user.
It is possible that a user might say something that annoys you or just doesn’t interest
you. In this case you can make sure that the chat simply does not show you any of
their contributions. Obviously it will not throw them out of the channel, but you will not
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see what they do, which is more or less the same. To ignore a user, select their name
and click on the Ignore button. Their name will appear preceded by the symbol ~ and
from that moment, you won’t see what they write. When a channel is very busy, or
when you don’t know in which channel to look, it may be difficult to locate users whose
names you know from previous sessions. The Search button will help you in this task.
When you press it, a window will open in which you can write the nickname you are
looking for. When pressing the OK button, it will tell you in which channels they are
connected at that moment, if they are connected. The Options buttons is used to define
some adjustments of the chat operation, such as the use of images, sound, or if you
want any additional information shown. This last option will show you a message each
time that someone enters or leaves the channel, in the same way as happens with the
IRC chats.

7.3 Continuous Connection: Windows Live Messenger

The MSN Messenger is a well-known instant messaging program for the Windows
system. It was recently re-named ‘Windows Live Messenger in its version number 8.
This denomination really encompasses three different programs:
MSN Messenger: This is an instant messaging client and its name is used to refer to all
the messaging programs by Microsoft.
Windows Messenger: This is installed with Windows XP and is a basic instant
messenger client, which does not support many characteristics of these (editing,
images, etc.). However, it is capable of connecting to the Communications Service and
Instant Messaging Exchange used by some companies (for this it is known as a
company version) and allows the control of a machine in a remote way similar to
NetMeeting. It allows two connection methods: RVP (old protocol used in version of
Exchange prior to 2003) and SIP/Simple.
MSN Web Messenger. Version via the client’s web appeared in August 2004. It has
similar characteristics to MSN Messenger in a navigator for Windows connected to the
Internet. Its usefulness is that it can connect with a mail account from one computer
that doesn’t have the program installed.
The three programs can use the same protocol due to the fact that many of their
characteristics are similar.
To use the service you need a Microsoft Passport account. It allows you to use text as
well as emoticons, animated emoticons (GIF), handwriting (picture), games or the
exchange of shared files. It also allows voice conversations, through a digital camera
and if it is installed in the Windows Messenger system, it is possible to allow the remote
control of the computer to contacts (restricted to what tasks can be carried out) from
clients without web.
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It makes up part of the services offered by the MSN portal that includes e-mail with
Hotmail or a search engine.
Although MSN Messenger is the program or official client, there are a multitude of
compatible clients with its protocol (in spite of being a closed protocol) that can be used
in its place.
The latest version of MSN Messenger is called Windows Live Messenger and is only
compatible with the Microsoft Windows XP operating system. This version includes the
possibility of making phone calls to fixed landlines and mobiles through its VoIP
service, as well as having the possibility of adding contacts from Yahoo Messenger.
These are the steps needed to download, install and configure MSN on your system.

Connect to the Internet and start your favourite Web page explorer, which could be
Internet Explorer.
Write http://www.msnmessenger.ms/ in the Address field of the navigator and press Enter.
The MSN Messenger web page will open.
Click on the link called Download new windows live messenger 8.1
Your navigator will probably warn you of the dangers of downloading a file if you are
not sure of its origin. As you have accessed the file from the official Web program,
there are no problems. The program that will be downloaded is a Windows installer, so,
on this occasion click on the Open button to aid this process.

When you finish downloading, you will be shown a welcome window. Click on the Next
button. You will then be able to look at the terms of the license. Read it carefully, and if
you are in agreement with what is written, activate the Accept button for the terms of
the licensing contract and click on the Next button.
The installation program will copy the necessary files onto your disc and will create a
shortcut in the Start menu. When it has finished, click on the Finish button.

Starting a session
You now have the latest version of MSN Messenger on your system. You will now
discover how to configure it in order to get it working and be able to converse with other
users.
1. Go to the Start > Programs > Windows Live Messenger menu. At that moment
a window will appear on screen and at the same time the program will place a
small icon in the Windows Notification area. The Notification area is the small
information bar that occupies the bottom right corner of the Windows screen.
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2. If you have a Hotmail or .NET Passport account that you have used from this
system, MSN Messenger will try to connect you with this identification data to
the message service. If not, click on the Initiate a session with a different
account link.
3. Messenger will show you a window in which you should write your Hotmail email address and your password. The Start session box can be used so that
MSN Messenger remembers this information and uses it next time. Click on
OK.
4. After a few seconds, if all the data is correct, Messenger will connect you to the
message system. You are now connected!
The first thing you should do is configure the basic working aspects of Windows Live
Messenger. To do this, go to the Tools > Options menu. A window will open on the
screen with various tabs at the top. The two most important ones at the moment are
Personal and General.
Inside the Personal tab, you will be able to choose the name with which the rest of the
users will see, as well as the information in your personal profile. You will also be able
to define the time that goes by without any activity before which Messenger changes
your status to absent. In the General tab, the most interesting fields are those which
are grouped into the Sign in session and Messages. In the first, select the
‘Automatically run Windows Live Messenger when I log on to Windows’ box if you want
the program to start automatically.
The ‘Allow automatic sign in when connected to the Internet’ option will make the
connection automatic. To do this, it is necessary to introduce the data correctly and
activate the Start session automatically in the identification window. In the Messages
tab you will be able to choose what messages you want to receive and in what way.
When you have finished, click on OK.
The Messenger window

The Windows Live Messenger program has a very discreet look, once working on your
computer. If it hasn’t connected, it will probably only appear in the notification area.
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Once authorized, the normal thing is that it occupies a small part of the screen with its
control window. This window is made up of the following elements.
In the upper part there is a menu bar, from which you will be able to access all
functions of the program. Under it you will find a graphic element which shows the
identifier used to connect with the Messenger Network as well as the status of the other
users. A little lower you will see the area in which Messenger informs you of your
account status. Firstly it will show you if you have messages pending in the Hotmail
account associated with its identifier. A simple click on the text shown will open a
navigational window which will be connected with your Hotmail account in order to
access your e-mail inbox.
Following this, all the contacts which have been signed up will be visualized.
In the top part, under the Online heading, you will be able to see all those users which
are connected at that moment. Under the Without Connection title, you will see the
users that are not connected. In both cases, on the right of the heading you will see a
bracket with the number of users that this category contains. In the next section it will
be explained how to sign up your friends and contacts in order to be able to
communicate with them through MSN Messenger.
Under the blank zone with information on the users you can find a Task pane with the
title Wishes…. From here you will be able to quickly access the most common tasks,
such as Add a contact, Send an Instant Message, Send a file or photo, Make a
telephone call or Go to chat rooms, as well as many others. In the following sections of
this chapter some of these options will be dealt with in detail. On clicking on the icon
with two small arrows on the right of the title Wishes … this panel will contract and
leave more free space on the screen. Finally, on the left side of the window there are
various tabs which will take you to different MSN Services, such as a notices system,
stock market prices, booking holidays etc. These services constantly change given that
this is a space which MSN shares between its own services and those which different
companies rent from them.

Operation of Messenger
Messenger reduces distances on the Internet. In one way, it makes the Internet behave
like a big room in which all its users are present. In this way, each time that somebody
you know is connected (just like entering or leaving this big room) you will be able to
see them and from that point on start up a conversation with them or share files or
applications. Until the arrival of Instant Messaging programs it was very common that
various people known to each other were connected at the same time but without
knowing so. The cost per minute of Internet connection is much lower than by landline
phone, mobile, or any other system. This makes the possibility of connecting with other
users when they are all online especially interesting.
To be able to do this, two elements are necessary: a communication system that
informs each user of the state of their connection of their list of contacts and a system
that allows them to converse and share information. The communication system forms
the group of millions of Messenger users with this program executing itself on their
computers and the central MSN servers. All together put the group of users in contact.
The second element brings the communication functions included in Messenger.
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Once you get used to using MSN Messenger daily, you will not be able to imagine how
your life was before. You will make fewer phone calls, send fewer SMS text messages
and send fewer e-mails. Messenger will replace all these gaps with less effort and cost,
and in less time than before. The only problem is that you may spend too much time on
the keyboard and there won’t be enough time to do other things. You have been
warned!
Adding contacts

To register somebody, follow these steps:
Click on the Add a contact button. A window will open in which you will be able to
choose the method to look for the user.
Obviously, the person you are looking for has to be a MSN Messenger user, so the
system offers us various possibilities: by their e-mail address or session start name or
from my address book. Select whichever you think is the most suitable and click on the
Next button. In this case we will use the first of these.
Write the mail address of the person you are looking for and click on Next.
Messenger will show you a window informing you that you have added the contact to
the list. Click on Finish.
One of the options that you can customize in Messenger is the way of processing
subscription applications. It is usual to define it so that the system asks you for
confirmation each time that someone applies to be included in your contact list. For this
reason, it is possible that some of the contacts that are subscribed are not operative,
even having followed the previous steps. In general you will have to wait for those
users to be connected, see their application, and normally, accept it. From that moment
on, when you are connected they will already be present in your list.
Sending messages
Once a list of contacts is defined, the next stage consists of starting up a conversation
with one of your contacts. To achieve this, double click on their name or right click and
select it.
Sending an instant message
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A new window will open in which you will be able to write the text that you want. What
you write will be the first thing that your contact sees, so it is recommendable to start
with a greeting and a simple description of your intentions. The way this window works
is very similar to that of any other chat window system. Everyone writes their
contributions in the line in the bottom part while, in the top part it will go on showing you
the written contents in all parts. The conversations in MSN Messenger are not limited
to two people. Any of the two original members can invite any person from their contact
list or to someone whose details they know, which you can locate in the same way as
signing up a contact.
Something more than text

You can liven up the contents of your message with Change the font or the colour of
the text buttons, with which you can change the appearance of the text, or with Select a
gesture icon. The history of chats and electronic messages is linked to the very popular
smileys or emoticons.
We have to remember that the first computers that were part of the Internet network
lacked the possibility of showing or sending graphics, they could only work with text
characters. For this reason, the users tried very hard to make the most of the possible
standard characters to add to the text messages part of the intention and meaning that
goes with the gestured information that occurs when one person talks to another. A
simple question such as: ’What happened the other day?’ could be interpreted in a
positive or negative way. Furthermore, it very often depends on the state of mind of the
recipient. This is why constructions such as “:-)” clarify the happy tone of the text. To
understand this sign, look at it with your head turned to the right. It is a caricature of a
smiling face. The Select a gestured icon button will allow you to use this type of
information in a more graphic and elaborated way and so make clear the tone of your
message for those who have to interpret your messages.
Files and images
Communication with Messenger isn’t just limited to sharing text phrases. You can also
send files of all types. To do this, click on the Send a file or a photo link. A window will
open with the contents of your system. Scroll to the folder in which the file you are
looking for is. Select it and press the OK button. The addressee of your file should
accept the reception with a click in the OK link. When they do so, Messenger will show
you a warning of the dangers of receiving a file from an unknown origin and the ways to
minimise this danger. After reading this, if you press on OK again, it will begin to
download. When finished, both users will receive a confirmation message in their
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respective windows. The message shown to the recipient of the file will also indicate, in
which folder of your disc it has stored the file as well as the name it has.
Audio and video

The additional possibilities of Messenger are not only the simple transfer of files, but
that you can also start real voice conversations and even voice and video. If you have
a Webcam or a special camera for videoconferences, you can click on the Start the
camera link to start it working. It isn’t necessary for both users to have a Webcam or a
sound and microphone card. If they do have, then all the better, but it’s not absolutely
necessary.
Once the recipient accepts the invitation, the video and sound transmission will begin in
real time. Take into account the quantity of information collected by the Webcam and
by the sound card, will usually be superior to the connection capacity at the two ends of
the Internet. For this reason, the video will not be as fluid as would be wanted and
there may be cuts in the sound. Messenger will do everything possible to optimize the
band width available, but unfortunately it can’t work miracles. If the line does not accept
all the information generated, you will have to discard part of it.
At the same time as maintaining a videoconference or a voice conference session, you
can continue writing in the usual way. One of the most interesting characteristics of
MSN Messenger is that it allows you to use various types of communication (text,
graphics, video, sound, etc) and furthermore several of these at the same time.
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8 FTP and P2P
8.1 FTP

FTP is one of the various protocols of the Internet network, it stands for File Transfer
Protocol and it is used to transfer large blocks of data through the network. Its
behaviour is defined by the RFC 959 reference.
This requires a FTP Server and a FTP client, it could be the case that the servers are
of free access for everyone and then we are talking about an anonymous login or
anonymous FTP.
The mayority of the web pages on a world level are uploaded to the respective servers
through this protocol.
By default it uses the ports 20 and 21. Port 20 is that used for the flow of data between
the client and the server and port 21 is used for flow control, that is, to send the orders
from the client to the server. While they transfer data through the flow of data, the flow
control remains waiting. This may cause problems in the event of transferring very
large data carried out through firewalls which interrupt sessions after long periods
waiting. The file may have been transferred successfully, but the firewalls can
disconnect the control session, so that an error is generated.
You can also use the FTP protocol using a web navigator with an address type
ftp://usuario:contraseña@servidor, such as:
ftp://usulec:clavel@archivos.miempresa.com
You can use wget. This program receives a URL and can be downloaded just like all
the documents that link to it (and the linked documents link in a recursive way).

8.2 P2P
Broadly speaking, a peer to peer computer network or P2P as it is better known, refers
to a network that doesn’t have clients or fixed servers, but a series of nodes that
behave simultaneously as clients and as servers of the other nodes of the network.
This model network contrasts with the client-server model, which runs a monolithic
architecture where there isn’t task distribution among them, only a simple
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communication between a user and a terminal where the client and the Server can’t
change roles.

Any node can start, stop or complete a compatible transaction. The efficiency of the
nodes in the link and transmission of data, can vary depending on the local
configuration (firewalls, NAT, etc.), the speed of the process, the availability of
broadband from its connection to the network and storage capacity on the disc.
At present the most famous P2P client is Emule.

8.2.1 EMULE

eMule is a program to Exchange files with the P2P system using the eDonkey 2000
protocol and the Kad network, published as free software for Microsoft Windows
systems.
Created at the beginning as an alternative to the eDonkey program, in a short period of
time it overtook it in functions, and because it was free, as well as other things, it
managed in a short period of time to overtake it in popularity, becoming one of the most
used programs by P2P users. There are also multiple programs derived from it with the
objective of carrying it to other operating systems, such as xMule or aMule.
History
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The eMule Project was started on 13th May 2002 by Hendrik Breitkreuz (also know as
Merkur) who was not satisfied with the original client eDonkey2000. Its name is short for
electronic mule, making referent to eDonkey from where it originated.
Over time, seven other developers joined the project. The source code was published
for the first time as the 0.02 version in SourceForge on 6th July of the same year.
eMule was launched for the first time as binary on 4th August in the 0.05a version. The
‘credit system’ was implemented for the first time on 14th September in the 0.19a
version. The web site of the project was launched on 8th December. From that
moment, eMule has been downloaded around 240 million times (figures as of October
2006).
At present the project is made up of sixteen people: 2 developers, 2 project
coordinators (including the founder Brietkreuz), 3 testers, and 9 debuggers. The official
site is maintained by seven developers and 4 moderators or administrators.

8.2.2 Characteristics
Its main characteristics are:
 Direct exchange of files among its clients.
 Fast recuperation of corrupted parts.
The complementary use of a network without servers, called Kademlia, of promising
expectations; as well as in some modes (modified versions) the use of the Webcache
option has been implemented, as an extra method and as a help for downloading files
(see eMule Morph).
The fact that on being licensed under GPL, any user can freely collaborate and modify
it, is the reason why a complete series of modifications (modes) of the program have
proliferated, such as Morph, Phoenix, Plus or NeoMule. There are even independent
projects based on its code such as eMule clients for other operating systems, like
aMule. All of these contribute to a continual improvement not just of the original
program, but also its derivatives.
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It uses a credits system so that those who most upload to the web also most download,
though it can also function with this system deactivated. The credits allow you to
advance more quickly in the client waiting queue, in this way you can achieve a more
suitable position to download. Given that the credits are registered in a decentralized
way, for each one of the users of the web, to avoid being falsified, we will only give
credits to the users who have uploaded any file (although they only affect the advance
in the waiting queue, we can download from a user to which we have never uploaded a
file).
From each user parts of a file are downloaded (which can be being downloaded at this
moment by other users) that assemble on finishing to form a complete file. This P2P
network is especially useful when the files that you are trying to download are rather
large. Another of the advantages of this network is the possibility of finding very
unusual files.
Its wide implementation, as well as its decentralized character, has made it the
preferred option by the majority of users ready to “share contents”. These same
reasons have increased the controversy over the necessity or not of international
legislation to watch over intellectual property rights and penalise acts which can violate
this.
It has the possibility of sending messages to users of the eDonkey 2000 network
connected to the downloads in progress and of IRC chat in order to look for information
which interests the users.

8.2.3 Operation of the networks
Nowadays, eMule has two networks: the classic network based on eD2K servers and a
decentralized network (Kad) which does not use servers and is based on Kademlia.
Now the basic operation concepts are explained, and then later how these objectives
are achieved in each of the two networks:
File identification. All the files have an associated hash value, a hexadecimal key,
which identifies a particular file in a unique way, although it has various names, in a
way that the same file has different users, although any one of them has changed the
name, it continues being the same file. In addition to this, all the files are separated into
blocks of 9.28 MB (9500 KB), and each one of the parts has its own hash value, in a
way that the final hash value of the file is a combination of the hash values of all parts.
Identification of other clients: Each user has an assigned unique and permanent hash
value that is protected by an algorithm of encryption of public keys.
Downloading of data: Once a client has found a source for the download of a particular
file, they then get in contact to ask for a place in the download queue. The source
reserves a place in its queue, which has to periodically make contact with the source
(more or less once every half an hour). When you reach first position in the queue, the
source opens a connection with the client to then proceed to get the file.
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8.2.4 Network of servers
To connect to this network you have to know the address of the IP Server. Once
connected to a server, this can tell us of any other servers. Aiming to keep this list up to
date, the servers are connected among themselves. When a node is connected to a
server it states which files it wants to share. To look for a file you send your enquiry to
one or more servers. Each server answers with a list of files which it has at its disposal.
To know the sources of a particular file, this information is then passed on to one or
more servers. Each server answers with a list of nodes that share the requested file.
The list of servers that eMule has can be updated, thereby allowing more precise and
extensive searches to be quicker.
There are false servers that collect information on who shares each file. For this reason
it is recommendable to obtain the server lists from trustworthy sources. The download
of a list of servers can be done automatically.

8.2.5 Kad Network
The Kad network is a totally decentralized network where all the nodes are the same. It
has been designed so that eMule can survive a possible crash of server networks. To
connect to this network you have to know the IP address of another node, but it is
possible to be connected from the nodes obtained from the server networks. Each
node knows a small part of the network, so that the size of the network can grow as
much as is necessary without affecting its performance. When a node connects, it
stores the file identifiers that you want to share within other nodes, chosen depending
on the file identifier. When you want to download a file, the nodes which are indexed
are localized and these nodes return the sources list for this specific file. The search by
name works in a similar way, saving the name of the file inside other nodes, chosen
depending on each word in the name. A search in Kad is always carried out throughout
the network.

8.2.6 KaZaa
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8.2.7 Looking for files
Looking for files in eMule normally means that all the servers from the list of servers
are asked if they know any client that has a file which coincides with the terms of the
search. The servers themselves do not store any file, they only generate a list of files
from the connected users. The eMule advanced search function allows us to do precise
searches for files on the network. A search with precision is better, as the general
searches suppose a considerable load for the servers.
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